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2
 About Digital Video Editing
When you edit video, you arrange source 

clips so that they tell a story. That story 

can be anything from a fictional 

television program to a news event and 

more. Understanding the issues that 

affect your editing decisions can help you 

prepare for successful editing and save 

you valuable time and resources.
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This lesson describes the role of Adobe Premiere in video production and introduces a 

variety of key concepts:

• Measuring video time.

• Measuring frame size and resolution.

• Compressing video data.

• Capturing video.

• Superimposing and transparency.

• Using audio in a video.

• Creating final video.

How Adobe Premiere fits into video production
Making video involves working through three general phases:

Preproduction Involves writing the script, visualizing scenes by sketching them on a 

storyboard, and creating a production schedule for shooting the scenes.

Production Involves shooting the scenes.

Post-production Involves editing the best scenes into the final video program, correcting 

and enhancing video and audio where necessary. Editing includes a first draft, or rough 

cut (or offline edit), where you can get a general idea of the possibilities you have with the 

clips available to you. As you continue editing, you refine the video program through 

successive iterations until you decide that it’s finished. At that point you have built the 

final cut or online edit. Premiere is designed for efficient editing, correcting, and 

enhancing of clips, making it a valuable tool for post-production. 

The rest of this chapter describes fundamental concepts that affect video editing and 

other post-production tasks in Premiere. All of the concepts in this section and the 

specific Premiere features that support them are described in more detail in the Adobe 

Premiere 6.0 User Guide and Premiere 6.5 User Guide Supplement.
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If any stage of your project involves outside vendors, such as video post-production 

facilities, consult with them before starting the project. They can help you determine 

what settings to use at various stages of a project and can potentially help you avoid costly, 

time-consuming mistakes. For example, if you’re creating video for broadcast, you should 

know whether you are creating video for the NTSC (National Television Standards 

Committee) standard used primarily in North America and Japan; the PAL (Phase 

Alternate Line) standard used primarily in Europe, Asia, and southern Africa; or the 

SECAM (Sequential Couleur Avec Memoire) standard used primarily in France, the 

Middle East, and North Africa.

Measuring video time
In the natural world, we experience time as a continuous flow of events. However, 

working with video requires precise synchronization, so it’s necessary to measure time 

using precise numbers. Familiar time increments—hours, minutes, and seconds—are 

not precise enough for video editing, because a single second might contain several 

events. This section describes how Premiere 6.5 and video professionals measure time, 

using standard methods that count fractions of a second in terms of frames.

How the timebase and frame rates affect each other

You determine how time is measured in your project by specifying the project timebase. 

For example, a timebase of 30 means that each second is divided into 30 units. The exact 

time at which an edit occurs depends on the timebase you specify, because an edit can 

only occur at a time division; using a different timebase causes the time divisions to fall 

in different places.

The time increments in a source clip are determined by the source frame rate. For example, 

when you shoot source clips using a video camera with a frame rate of 30 frames per 

second, the camera documents the action by recording one frame every 1/30th of a 

second. Note that whatever was happening between those 1/30th of a second intervals is 

not recorded. Thus, a lower frame rate (such as 15 fps) records less information about 

continuous action, while a high frame rate (such as 30 fps) records more. 

You determine how often Premiere generates frames from your project by specifying the 

project frame rate. A project frame rate of 30 frames per second means that Premiere will 

create 30 frames from each second of your project.
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For smooth and consistent playback, the timebase, the source frame rate, and the project 

frame rate should be identical. 

Note: NTSC was originally designed for a black-and-white picture at 30 fps, but signal 

modifications made in the mid-20th century to accommodate color pictures altered the 

standard NTSC frame rate to 29.97 fps.

Sometimes the time systems don’t match. For example, you might be asked to create a 

video intended for CD-ROM distribution that must combine motion-picture source clips 

captured at 24 fps with video source clips captured at 30 fps, using a timebase of 30 for a 

final CD-ROM frame rate of 15 fps. When any of these values don’t match, it is 

mathematically necessary for some frames to be repeated or omitted; the effect may be 

distracting or imperceptible depending on the differences between the timebase and 

frame rates you used in your project.

A. 30 fps video clip (one-half second shown) B. Timebase of 30, for a video production 
When the source frame rate matches the timebase, all frames display as expected.

Editing Video Type Frames per second

Motion-picture film 24 fps

PAL and SECAM video 25 fps

NTSC video 29.97 fps

Web or CD-ROM 15 fps 

Other video types, 
e.g., non-drop frame editing, 3-D animation

30 fps

01 02 03 04 05 06 07 08 09 10 11 12 13 14 15

01 02 03 04 05 06 07 08 09 10 11 12 13 14 15A

B
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A. 24 fps motion-picture source clip (one-half second shown) B. Timebase of 30, for a 
video production. To play one second of 24 fps frames at a timebase of 30, source frames 
1, 5, and 9 are repeated.

It is preferable to capture your clips at the same frame rate at which you plan to export 

your project. For example, if you know your source clips will be exported at 30 fps, capture the 

clips at 30 fps instead of 24 fps. If this is not possible (for example, DV can only be captured 

at 29.97 fps), you’ll want to output at a frame rate that evenly divides your timebase. So, if 

your capture frame rate and your timebase are set at 30 fps (actually 29.97), you should 

output at 30, 15, or 10 fps to avoid “jerky” playback.

When time systems don’t match, the most important value to set is the timebase, which 

you should choose appropriately for the most critical final medium. If you are preparing 

a motion picture trailer that you also want to show on television, you might decide that 

film is the most important medium for the project, and specify a timebase of 24.

A. Timebase of 30 (one-half second shown) B. Final frame rate of 15, for a Web movie
If the timebase is evenly divisible by the frame rate, timebase frames are included evenly.

A. Timebase of 24 for a motion-picture film (one-half second shown) B. Final frame 
rate of 15, for a Web movie. The time is not evenly divisible by the frame rate, so frames 
are included unevenly. A final frame rate of 12 fps would generate frames more evenly.

A

B

01 02 03 04 05 06 07 08 09 10 11 12

01 01 02 03 04 05 05 06 07 08 09 09 10 11 12

01 02 03 04 05 06 07 08 09 10 11 12 13 14 15A

B

01 02 03 04 05 06 07 08 09 10 11 12A

B
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The important thing to remember is this: You’ll get the most predictable results if 

your timebase and frame rate are even multiples of one another; you’ll get the best 

results if they are identical. 

 For more information, see “Measuring time and frame size” in the Adobe Premiere 6.0 

Technical Guides found in the Support area on the Adobe Web site 

(www.adobe.com/products/premiere/community.html).

Counting time with timecode

Timecode defines how frames are counted and affects the way you view and specify time 

throughout a project. Timecode never changes the timebase or frame rate of a clip or 

project—it only changes how frames are numbered.

You specify a timecode style based on the media most relevant to your project. When you 

are editing video for television, you count frames differently from counting frames when 

editing video for motion-picture film. By default, Premiere displays time using the 

SMPTE (Society of Motion Picture and Television Engineers) video timecode, where a 

duration of 00:06:51:15 indicates that a clip plays for 6 minutes, 51 seconds, and 15 

frames. At any time, you can change to another system of time display, such as feet and 

frames of 16mm or 35mm film. Professional videotape decks and camcorders can read 

and write timecode directly onto the videotape, which lets you synchronize audio, video, 

and edits, or edit offline (see Capturing DV on page 108).

When you use the NTSC-standard timebase of 29.97, the fractional difference between 

this timebase and 30 fps timecode causes a discrepancy between the displayed duration of 

the program and its actual duration. While tiny at first, this discrepancy grows as program 

duration increases, preventing you from accurately creating a program of a specific 

length. Drop-frame timecode is an SMPTE standard for 29.97 fps video that eliminates this 

error, preserving NTSC time accuracy. Premiere indicates drop-frame timecode by 

displaying semicolons between the numbers in time displays throughout the software, 

and displays non-drop-frame timecode by displaying colons between numbers in 

timecode displays. 
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Drop-frame timecode uses semicolons (left)
and non-drop-frame timecode uses colons (right).

When you use drop-frame timecode, Premiere renumbers the first two frames of every 

minute except for every tenth minute. The frame after 59:29 is labeled 1:00:02. No frames 

are lost because drop-frame timecode doesn’t actually drop frames, only frame numbers.

 For more information, see “Timecode and time display options” in the Adobe Premiere 

6.0 Technical Guides found in the Support area on the Adobe Web site (www.adobe.com/

products/premiere/community.html).

Interlaced and non-interlaced video 

A picture on a television or computer monitor consists of horizontal lines. There is more 

than one way to display those lines. Most personal computers display using progressive 

scan (or non-interlaced) display, in which all lines in a frame are displayed in one pass 

from top to bottom before the next frame appears. Television standards such as NTSC, 

PAL, and SECAM standards are interlaced, where each frame is divided into two fields. 

Each field contains every other horizontal line in the frame. A TV displays the first field 

of alternating lines over the entire screen, and then displays the second field to fill in the 

alternating gaps left by the first field. One NTSC video frame, displayed approximately 

every 1/30th of a second, contains two interlaced fields, displayed approximately every 

1/60th of a second each. PAL and SECAM video frames display at 1/25 of a second and 

contain two interlaced fields displayed every 1/50th of a second each. The field that 

contains the topmost scan line in the frame is called the upper field, and the other field is 

called the lower field. When playing back or exporting to interlaced video, make sure the 

field order you specify matches the receiving video system, otherwise motion may appear 

stuttered, and edges of objects in the frame may break up with a comb-like appearance.

Note: For analog video, the field order needs to match the field order of the capture card 

(which should be specified in the preset). For DV, the field order is always lower field first. Be 

sure to select the correct preset first; doing so will correctly specify the field order.
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Interlaced video describes a frame with two passes of alternating scan lines.

Progressive-scan video describes a frame with one pass of sequential scan lines.

If you plan to slow down or hold a frame in an interlaced video clip, you may want to 

prevent flickering or visual stuttering by de-interlacing its frames, which converts the 

interlaced fields into complete frames. If you’re using progressive-scan source clips (such 

as motion-picture film or computer-generated animation) in a video intended for an 

interlaced display such as television, you can separate frames into fields using a process 

known as field rendering so that motion and effects are properly interlaced.

 For more information, see “Processing interlaced video fields” in Chapter 3 of the Adobe 

Premiere 6.0 User Guide and “Interlaced and non-interlaced video” in the Adobe Premiere 
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Technical Guides found in the Support area on the Adobe Web site 

(www.adobe.com/products/premiere/community.html).

Measuring frame size and resolution
Several attributes of frame size are important when editing video digitally: pixel and frame 

aspect ratio, clip resolution, project frame size, and bit depth. A pixel (picture element) is 

the smallest unit that can be used to create a picture; you can’t accurately display anything 

smaller than a pixel.

Aspect ratio

The aspect ratio of a frame describes the ratio of its width to its height in the dimensions 

of a frame. For example, the frame aspect ratio of NTSC video is 4:3, whereas DVD, 

HDTV, and motion-picture frame sizes use the more elongated aspect ratio of 16:9.

A frame using a 4:3 aspect ratio (left), and a frame using the 16:9 aspect
ratio (right)

Some video formats use a different aspect ratio for the pixels that make up the frame. 

When a video using non-square pixels (that is, pixels that are taller than they are wide, or 

wider than they are tall) is displayed on a square-pixel system, or vice versa, shapes and 

motion appear stretched. For example, circles are distorted into ellipses.

Frame with square pixels (left), frame with tall horizontal pixels (center), and center 
frame again displayed using square pixels (right)

3

4 16

9
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Non-square pixels

Premiere provides support for a variety of non-square pixel aspect ratios, including 

DV’s Widescreen (Cinema) pixel aspect ratio of 16:9 and the Anamorphic pixel aspect 

ratio of 2:1.

When you preview video with non-square pixel aspect ratios on your computer screen, 

Premiere displays a corrected aspect ratio on the computer monitor so that the image is 

not distorted. Motion and transparency settings, as well as geometric effects, also use the 

proper aspect ratio, so distortions don’t appear after editing or rendering your video.

Frame size

In Premiere, you specify a frame size for playing back video from the Timeline and, if 

necessary, for exporting video to a file. Frame size is expressed by the horizontal and 

vertical dimensions, in pixels, of a frame; for example, 640 by 480 pixels. In digital video 

editing, frame size is also referred to as resolution. 

In general, higher resolution preserves more image detail and requires more memory 

(RAM) and hard disk space to edit. As you increase frame dimensions, you increase the 

number of pixels Premiere must process and store for each frame, so it’s important to 

know how much resolution your final video format requires. For example, a 720 x 480 

pixel (standard DV) NTSC frame contains 345,600 pixels, while a 720 x 576 PAL image 

contains 414,720 pixels. If you specify a resolution that is too low, the picture will look 

coarse and pixelated; specify too high a resolution and you’ll use more memory than 

necessary. When changing the frame size, keep the dimensions proportional to the 

original video clip.
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If you plan to work with higher resolutions or you are concerned about your CPU’s 

processing capabilities, you can specify one or more scratch disks for additional RAM and 

hard disk space. For more information, see “Setting up Premiere’s scratch disks” in Chapter 1 

of the Adobe Premiere 6.0 User Guide.

Overscan and safe zones

Frame size can be misleading if you’re preparing video for television. Most NTSC 

consumer television sets enlarge the picture; however, this pushes the outer edges of the 

picture off the screen. This process is called overscan. Because the amount of overscan is 

not consistent across all televisions, you should keep action and titles inside two safe 

areas—the action-safe and title-safe zones. 

The action-safe zone is an area approximately 10% less than the actual frame size; the 

title-safe zone is approximately 20% less than the actual frame size. By keeping all 

significant action inside the action-safe zone and making sure that all text and important 

graphic elements are within the title-safe zone, you can be sure that the critical elements 

of your video are completely displayed. You’ll also avoid the distortion of text and 

graphics that can occur toward the edges of many television monitors. Always anticipate 

overscan by using safe zones, keeping important action and text within them, and testing 

the video on an actual television monitor.

You can view safe zones in the Monitor window’s Source view, Program view, or both.

Safe zones in the Program view: A. Title-safe zone B. Action-safe zone

A

B
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Safe zones are indicated by white rectangles in Premiere’s Title Designer window. 

A. Title-safe zone B. Action-safe zone 
C. Overscan area D. Perimeter of frame

For more information on customizing safe zones in the Monitor and Title windows, see 

Lesson 8, “Creating with the Title Designer” in this book.

Bit depth

A bit is the most basic unit of information storage in a computer. The more bits used to 

describe something, the more detailed the description can be. Bit depth indicates the 

number of bits set aside for describing the color of one pixel. The higher the bit depth, the 

more colors the image can contain, which allows more precise color reproduction and 

higher picture quality. For example, an image storing 8 bits per pixel (8-bit color) can 

display 256 colors, and a 24-bit color image can display approximately 16 million colors.

The bit depth required for high quality depends on the color format that is used by your 

video-capture card. Many capture cards use the YUV color format, which can store high-

quality video using 16 bits per pixel. Before transferring video to your computer, video-

capture cards that use YUV convert it to the 24-bit RGB color format that Premiere uses. 

For the best RGB picture quality, you should:

• Save source clips and still images with 24 bits of color (although you can use clips with 

lower bit depths). 

• If the clip contains an alpha channel mask, save it from the source application using 32 

bits per pixel (also referred to as 24 bits with an 8-bit alpha channel, or millions of colors). 

For example, QuickTime movies can contain up to 24 bits of color with an 8-bit alpha 

channel, depending on the exact format used. 

A

C

B

D
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Internally, Premiere always processes clips using 32 bits per pixel regardless of each clip’s 

original bit depth. This helps preserve image quality when you apply effects or 

superimpose clips.

If you’re preparing video for NTSC, you should keep in mind that although both 16-bit 

YUV and 24-bit RGB provide a full range of color, the color range of NTSC is limited 

by comparison. NTSC cannot accurately reproduce saturated colors and subtle color 

gradients. The best way to anticipate problems with NTSC color is to preview your 

video on a properly calibrated NTSC monitor during editing.

 For more information, see “Previewing on another monitor” in the Adobe Premiere 6.0 

Technical Guides found in the Support area on the Adobe Web site 

(www.adobe.com/products/premiere/community.html). 

Understanding video data compression
Editing digital video involves storing, moving, and calculating extremely large volumes of 

data compared to other kinds of computer files. Many personal computers, particularly 

older models, are not equipped to handle the high data rates (amount of video 

information processed each second) and large file sizes of uncompressed digital video. Use 

compression to lower the data rate of digital video to a range that your computer system 

can handle. Compression settings are most relevant when capturing source video, 

previewing edits, playing back the Timeline, and exporting the Timeline. In many cases, 

the settings you specify won’t be the same for all situations:

• It’s a good idea to compress video coming into your computer. Your goal is to retain as 

much picture quality as you can for editing, while keeping the data rate well within your 

computer’s limits.

• You should also compress video going out of your computer. Try to achieve the best 

picture quality for playback. If you’re creating a videotape, keep the data rate within the 

limits of the computer that will play back the video to videotape. If you’re creating 

video to be played back on another computer, keep the data rate within the limits of 

the computer models you plan to support. It you’re creating a video clip to be streamed 

from a Web server, keep an appropriate data rate for Internet distribution.
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Applying the best compression settings can be tricky, and the best settings can vary 

with each project. If you apply too little compression, the data rate may be too high for 

the system, causing errors such as dropped frames. If you apply too much compression, 

lowering the data rate too far, you won’t be taking advantage of the full capacity of the 

system and the picture quality may suffer unnecessarily. 

Note: DV has a fixed data rate of 3.5 megabytes per second, nominally 25 megabits per 

second; the DV standard compression ratio is 5:1.

Analyzing clip properties and data rate

Premiere includes clip analysis tools you can use to evaluate a file, in any supported 

format, stored inside or outside a project. 

1 Locate and select the Sailby.mov clip from Lesson 1 and click Open.

2 From Premiere, choose File > Get Properties For > File. 

The Properties window provides detailed information about any clip. For video files, the 

analyzed properties can include file size, number of video and audio tracks, duration, 

average frame, audio and data rates, and compression settings. You can also use the 

Properties window to alert you to the presence of any dropped frames in a clip you 

just captured. 
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3 Click Data Rate to view the data rate graph for the clip.

You can use the data rate graph to evaluate how well the output data rate matches the 

requirements of your delivery medium. It charts each frame of a video file to show you 

the render keyframe rate, the difference between compression keyframes and differenced 

frames (frames that exist between keyframes), and data rate levels at each frame. 

The data rate graph includes:

• Data rate: the white line represents the average data rate. 

• Sample size: the red bars represent the sample size of each keyframed frame. 

If there are differenced frames, they appear as blue bars, representing the sample size of 

the differenced frames between compression keyframes. In this case, there are not any.

4 When you are finished, close the Data Rate Graph window and the Properties window.

 For more information, see “Factors that affect video compression” in the Adobe Premiere 

Technical Guides found in the Support area on the Adobe Web site (www.adobe.com/

products/premiere/community.html).

Choosing a video compression method

The goal of data compression is to represent the same content using less data. You can 

specify a compressor/decompressor, or codec, that manages compression. A codec may 

use one or more strategies for compression because no single method is best for all 

situations. The most common compression strategies used by codecs and the kinds of 

video they are intended to compress are described in this section.
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Spatial compression Spatial (space) compression looks for ways to compact a single frame 

by looking for pattern and repetition among pixels. For example, instead of describing 

each of several thousand pixels in a picture of a blue sky, spatial compression can record 

a much shorter description, such as “All the pixels in this area are light blue.” Run-length 

encoding is a version of this technique that is used by many codecs. Codecs that use spatial 

compression, such as QuickTime Animation or Microsoft RLE, work well with video 

containing large solid areas of color, such as cartoon animation.

Digital images are composed of pixels (A), which consume a lot of disk space 
when stored without compression (B). Applying run-length encoding stores the 
same frame data in much less space (C).

In general, as you increase spatial compression, the data rate and file size decrease, and 

the picture loses sharpness and definition. However, some forms of run-length encoding 

preserve picture quality completely, but require more processing power.

Temporal compression Temporal (time) compression compacts the changes during a 

sequence of frames by looking for patterns and repetition over time. In some video clips, 

such as a clip of a television announcer, temporal compression will notice that the only 

pixels that change from frame to frame are those forming the face of the speaker. All the 

other pixels don’t change (when the camera is motionless). Instead of describing every 

pixel in every frame, temporal compression describes all the pixels in the first frame, and 

then for each frame that follows, describes only the pixels that are different from the
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previous frame. This technique is called frame differencing. When most of the pixels in a 

frame are different from the previous frame, it’s preferable to describe the entire frame 

again. Each whole frame is called a keyframe, which sets a new starting point for frame 

differencing. You can use Premiere to control how keyframes are created (see the Adobe 

Premiere 6.0 User Guide and Premiere 6.5 User Guide Supplement). Many codecs use 

temporal compression, including Cinepak. 

If you can’t set keyframes for a codec, chances are it doesn’t use temporal compression. 

Temporal compression works best when large areas in the video don’t change, and is less 

effective when the image constantly changes, such as in a music video.

In this animation clip, the only change is the circle moving around the ship.

A. Storing the clip without compression records all pixels in all frames.
B. Applying temporal compression creates a keyframe from the first 
frame, and subsequent frames record only the changes.

A

B
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Lossless compression Some codecs use lossless compression, which ensures that all of 

the information—and thus all of the quality—in the original clip is preserved after 

compression. However, preserving the original level of quality limits the degree to which 

you can lower the data rate and file size, and the resulting data rate may be too high for 

smooth playback. Lossless codecs, such as Animation (at the Best quality setting), are 

used to preserve maximum quality during editing or for still images where data rate is 

not an issue.

Note: To ensure smooth playback, full-frame, full-size video using lossless compression 

requires a very large defragmented hard disk and very fast computer system built for high 

data rate throughput.

Lossy compression Most codecs use lossy compression, which discards some of the original 

data during compression. For example, if the pixels making up a sky actually contain 78 

shades of blue, a lossy codec set for less-than-best quality may record 60 shades of blue. 

While lossy compression means some quality compromises, it results in much lower data 

rates and file sizes than lossless compression, so lossy codecs such as Cinepak or Sorenson 

Video are commonly used for final production of video delivered using CD-ROM or the 

Internet. 

Asymmetrical and symmetrical compression The codec you choose affects your 

production workflow, not just in file size or playback speed, but in the time required 

for a codec to compress a given number of frames. Fast compression speeds up video 

production, and fast decompression makes viewing easier; but many codecs take far 

more time to compress frames than to decompress them during playback. This is why 

a 30-second clip may take a few minutes to process before playback. A codec is 

considered symmetrical when it requires the same amount of time to compress as to 

decompress a clip. A codec is asymmetrical when the times required to compress and 

decompress a clip are significantly different.

Compressing video is like packing a suitcase—you can pack as fast as you unpack by 

simply throwing clothes into the suitcase, but if you spend more time to fold and organize 

the clothes in the suitcase, you can fit more clothes in the same space.

DV compression DV is the format used by many digital video camcorders. DV also 

connotes the type of compression used by these camcorders, which compress video right 

inside the camera. The most common form of DV compression uses a fixed data rate of 

25 megabits per second (3.5 megabytes per second) and a compression ratio of 5:1. This 
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compression is called “DV25.” Adobe Premiere 6.5 includes native support for DV25 and 

other DV codecs, and can read digital source video without further conversion. 

No single codec is the best for all situations. The codec you use for exporting your final 

program must be available to your entire audience. So, while a specialized codec that 

comes with a specific capture card might be the best choice for capturing source clips, it 

would not be a good choice for exporting clips, since it is unlikely that everyone in your 

audience would have that specific capture card and its specialized codec. This is a 

significant concern when exporting streaming media, since the three most popular 

streaming architectures (RealMedia, Windows Media, and QuickTime) use proprietary 

codecs in their players; a RealMedia stream, for example, cannot be played back through 

a Windows Media player, and vice versa. So, for the convenience of audiences with diverse 

players set as the default in their browsers, streaming media is usually encoded in multiple 

formats.

 For more information, see “Video codec compression methods” in the Adobe Premiere 

6.0 Technical Guides found in the Support area on the Adobe Web site (www.adobe.com/

products/premiere/community.html).

Capturing video
Before you can edit your video program, all source clips must be instantly accessible from 

a hard disk, not from videotape. You import the source clips from the source videotapes 

to your computer through a post-production step called video capture. Consequently, you 

must have enough room on your hard disk to store all the clips you want to edit. To save 

space, capture only the clips you know you want to use.

Source clips exists in two main forms:

Digital media Is already in a digital file format that a computer can read and process directly. 

Many newer camcorders digitize and save video in a digital format, right inside the camera. 

Such camcorders use one of several DV formats, which apply a standard amount of 

compression to the source material. Audio can also be recorded digitally; sound tracks are 

often provided digitally as well—on CD-ROM, for example. Digital source files stored on 

DV tape or other digital media, must be captured (transferred) to an accessible hard disk 

before they can be used in a computer for a Premiere project. The simplest way to capture 

DV is to connect a DV device, such as a camcorder or deck, to a computer with an IEEE 1394 

port (also known as FireWire or i.Link). For more sophisticated capture tasks, a specialized 
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DV capture card might be used. Premiere 6.5 supports a wide range of DV devices and 

capture cards, making it easy to capture DV source files.

Analog media Must be digitized. That means it must be converted to digital form and 

saved in a digital file format before a computer can store and process it. Clips from 

analog videotape (such as Hi-8), motion-picture film, conventional audio tape, and 

continuous-tone still images (such as slides) are all examples of analog media. By 

connecting an analog video device (such as an analog video camera or tape deck) and 

an appropriate capture card to your computer, Adobe Premiere can digitize, compress, 

and transfer analog source material to disk as clips that can then be added to your digital 

video project.

Note: Video-digitizing hardware is built into some personal computers, but often must be 

added to a system by installing a compatible hardware capture card. Adobe Premiere 6.5 

supports a wide variety of video capture cards.

If your system has an appropriate capture card, Adobe Premiere also lets you perform 

manual and time-lapse single-frame video captures from a connected camera or from a 

videotape in a deck or camcorder, using stop-motion animation. For example, you can 

point a camera at an unfinished building and use the time-lapse feature to capture frames 

periodically as the building is completed. You can use the stop-motion feature with a 

camera to create clay animations or to capture a single frame and save it as a still image. 

You can capture stop-motion animation from analog or DV sources.

Note: Premiere 6.5 supports device control. This enables you to capture stop motion, or 

perform batch capture of multiple clips, by controlling the videotape from within the Capture 

window in Premiere. However, stop motion does not require device control within Premiere: 

If you don't have a controllable playback device, you can manually operate the controls on 

your camcorder or deck and in the Capture window.

For more information on all the topics covered in this section on capturing video, see 

Chapter 2, “Capturing and Importing Source Clips” in the Adobe Premiere 6.0 User Guide.

Capturing DV 

When you shoot DV, the images are converted directly into digital (DV) format, right 

inside the DV camcorder, where your footage is saved on a DV tape cassette. The images 

are already digitized and compressed, so they are ready for digital video editing. The DV 

footage can be transferred directly to a hard disk. 
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To transfer DV to your hard disk, you need a computer with an OHCI-compliant 

interface and an IEEE 1394 (FireWire or i.Link) port (standard on newer Windows PCs 

and most newer-model Macintosh computers). Alternatively, you can install an 

appropriate DV capture card to provide the IEEE 1394 port. Be sure to install the 

accompanying OHCI-compliant driver and special Adobe Premiere plug-in software that 

may be required. Adobe Premiere 6.5 comes with presets for a wide variety of DV capture 

cards but, for some, you may need to consult the instructions provided with your capture 

card to set up a special preset.

Adobe Premiere 6.5 provides settings files for most supported capture cards. These presets 

include settings for compressor, frame size, pixel aspect ratio, frame rate, color depth, 

audio, and fields. You select the appropriate preset from the Available Presets list in the 

Load Project Settings dialog box when you begin your project. 

 To enhance DV capture, Adobe Premiere 6.5 provides device control for an 

extensive range of DV devices. See the Adobe Web site for a list of supported devices 

(www.adobe.com/premiere).

If you have an appropriate digital video device attached to or installed in your computer, 

you can do the following:

1 To specify the DV device in your computer, choose Edit > Preferences > Scratch Disks 

& Device Control. 

2 Click the Option button in the Preferences window to see the DV Device Control 

Options dialog box and select your DV device. Click OK. 
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Capturing analog video

When capturing analog video, you need to first connect the camcorder or deck to the 

capture card installed in your system. Depending on your equipment, you may have more 

than one format available for transferring source footage—including component video, 

composite video, and S-video. Refer to the instructions included with your camcorder 

and capture card. 

For convenience, most video-capture card software is written so that its controls appear 

within the Premiere interface, even though much of the actual video processing happens 

on the card, outside of Premiere. Most supported capture cards provide a settings file—a 

preset—that automatically sets up Premiere for optimal support for that card. Most of the 

settings that control how a clip is captured from a camera or a deck are found in the 

Capture Settings section of the Project Settings dialog box. Available capture formats vary, 

depending on the type of video-capture card installed.

 For more information, or if you need help resolving technical issues you may encounter 

using your capture card with Premiere, see the Adobe Premiere Web site (www.adobe.com/

premiere) for links to troubleshooting resources.
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Using the Movie Capture window

You use the Movie Capture window to capture DV and analog video and audio. To open 

and familiarize yourself with the Movie Capture window, from the title bar at the top of 

your screen choose File > Capture > Movie Capture. This window includes: 

• Preview window that displays your currently recording video.

• Controls for recording media with and without device control.

• Movie Capture window menu button.

• Settings panel for viewing and editing your current capture setting.

• Logging panel for entering batch capture settings (you can only log clips for batch 

capture when using device control). 

To set the Preview area so that the video always fills it, click the Movie Capture window 

menu button and choose Fit Image in Window.

Movie Capture window: A. Preview area B. Controllers
C. Movie Capture menu button D. Settings panel E. Logging panel

C
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Note: When doing anything other than capturing in Premiere, close the Movie Capture 

window. Because the Movie Capture window has primary status when open, leaving it open 

while editing or previewing video will disable output to your DV device and may diminish 

the performance.

Capturing clips with device control When capturing clips, device control refers to controlling 

the operation of a connected video deck or camera using the Premiere Interface, rather 

than using the controls on the connected device. You can use device control to capture 

video from frame-accurate analog or digital video decks or cameras that support external 

device control. It’s more convenient to simply use device control within Premiere rather 

than alternating between the video editing software on your computer and the controls 

on your device. The Movie Capture or Batch Capture windows can be used to create a list 

of In points (starting timecode) and Out points (ending timecode) for your clips. Premiere 

then automates capture—recording all clips as specified on your list. Additionally, 

Premiere captures the timecode from the source tape, so the information can be used 

during editing.

Note: If you’re working in Mac OS, the Enable Device control button runs all the way across 

the bottom of the window where the image is displayed.

Movie Capture window with device control enabled: 
A. Previous frame B. Next frame C. Stop D. Play
E. Play slowly in reverse F. Play slowly G. Preview area 
H. Jog control I. Shuttle control J. Take video K. Take audio
L. Rewind M. Fast forward N. Pause O. Record P. Set In
Q. Set Out R. Timecode S. Capture In to Out 

Capturing clips without device control If you don’t have a controllable playback device, you 

can capture video from analog or DV camcorders or decks using the Adobe Premiere 

Capture window. While watching the picture in the Movie Capture window, manually 

operate the deck and the Premiere controls to record the frames you want. You can use 

this method to facilitate capture from an inexpensive consumer VCR or camcorder. 

A B C D E F
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Using the Movie Capture window 
without device control: A. Take video
B. Take audio C. Record
D. Enable device control button

Batch-capturing video

If you have a frame-accurate deck or camcorder that supports external device control and 

a videotape recorded with timecode, you can set up Premiere for automatic, unattended 

capture of multiple clips from the same tape. This is called batch capturing. You can log 

(create a list of) the segments you want to capture from your tape, using the Batch 

Capture window. The list (called a batch list or timecode log) can be created either by 

logging clips visually using device control or by typing In and Out points manually. 

To create a new entry in the Batch List window, click the Add icon ( ). When your batch 

list is ready, click one button—the Capture button in either the Batch Capture or Movie 

Capture window—to capture all the specified clips on your list. To open and familiarize 

yourself with the Batch Capture window, from the title bar at the top of your screen, 

choose File > Capture > Batch Capture.

Batch Capture window: A. Check-mark column B. Sort by In point button
C. Capture button D. Add New Item button E. Delete selected button

Note: Batch Capture is not recommended for the first and last 30 seconds of your tape because 

of possible timecode and seeking issues; you will need to capture these sections manually.

C DBA

A B
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Components that affect video capture quality

Video capture requires a higher and more consistent level of computer performance—far 

more than you need to run general office software, and even more than you need to work 

with image-editing software. Getting professional results depends on the performance 

and capacity of all of the components of your system working together to move frames 

from the video-capture card to the processor and hard disk. The ability of your computer 

to capture video depends on the combined performance of the following components:

Video-capture card You need to have a video-capture card installed or the equivalent 

capability built into your computer to transfer video from a video camcorder, tape deck, 

or other video source to your computer’s hard drive. A video-capture card is not the same 

as the video card that drives your computer monitor. Adobe Premiere 6.5 software is 

bundled with many video-capture cards.

Note: Only supported video-capture cards should be used with Adobe Premiere. Not all 

capture cards certified for use with Adobe Premiere 5.x are certified for use with 6.x. Please 

refer to the list of certified capture cards found on the Adobe Web site 

(www.adobe.com/products/premiere/6cards.html).

Your video-capture card must be fast enough to capture video at the level of quality that 

your final medium requires. For full-screen, full-motion NTSC video, the card must be 

capable of capturing 30 frames (60 fields) per second at 640 x 480 pixels without dropping 

frames; for PAL and SECAM, 25 frames (50 fields) per second at 720 x 576 pixels. Even for 

Web video that will be output at a smaller frame size and a lower frame rate, you’ll want to 

capture your source material at the highest quality settings available. You’ll be using a lot of 

hard-disk space, but it’s better to start with high quality (more data) so you’ll have more 

choices about what information to discard when you reach the encoding stage. If you start 

with low quality (less data), you might regret having fewer options down the road.

Hard disk The hard disk stores the video clips you capture. The hard disk must be fast 

enough to store captured video frames as quickly as they arrive from the video card; 

otherwise, frames will be dropped as the disk falls behind. For capturing at the NTSC 

video standard of just under 30 frames per second, your hard disk should have an average 

(not minimum) access time of 10 milliseconds (ms) or less, and a sustained (not peak) 

data transfer rate of at least 3 MB per second—preferably around 6 MB per second. The 

access time is how fast a hard disk can reach specific data.
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The key to optimal performance is to have as much contiguous defragmented free space 

as possible on your hard disk. Fragmented disks greatly inhibit access for Real-Time, 

preview, capture, or playback.

The data transfer rate is how fast the hard disk can move data to and from the rest of the 

computer. Due to factors such as system overhead, the actual data transfer rate for video 

capture is about half the data transfer rate of the drive. For best results, capture to a 

separate high-performance hard disk intended for use with video capture and editing. 

The state of high-end video hardware changes rapidly; consult the manufacturer of your 

video-capture card for suggestions about appropriate video storage hardware.

Central processing unit (CPU) Your computer’s processor—such as a Pentium or PowerPC 

chip—handles general processing tasks in your computer. The CPU must be fast enough 

to process captured frames at the capture frame rate. A faster CPU—or using multiple 

CPUs in one computer (multiprocessing)—is better. However, other system components 

must be fast enough to handle the CPU speed. Using a fast CPU with slow components is 

like driving a sports car in a traffic jam.

Codec (compressor/decompressor) Most video-capture cards come with a compression chip 

that keeps the data rate within a level your computer can handle. If your video-capture 

hardware doesn’t have a compression chip, you should perform capture using a fast, high-

quality codec such as Motion JPEG. If you capture using a slow-compressing or lossy 

codec such as Cinepak, you’ll drop frames or lose quality.

Processing time required by other software If you capture video while several other 

programs are running (such as network connections, nonessential system enhancers, and 

screen savers), the other programs will probably interrupt the video capture with requests 

for processing time, causing dropped frames. Capture video while running as few drivers, 

extensions, and other programs as possible. In Mac OS, turn off AppleTalk. See the Mac 

OS documentation or online Help.

Data bus Every computer has a data bus that connects system components and handles 

data transfer between them. Its speed determines how fast the computer can move video 

frames between the video-capture card, the processor, and the hard disk. If you purchased 

a high-end computer or a computer designed for video editing, the data bus speed is likely 

to be well matched to the other components. However, if you’ve upgraded an older 

computer with a video-capture card, a faster processor, or a hard disk, an older data bus 
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may limit the speed benefits of the new components. Before upgrading components, 

review the documentation provided by the manufacturer of your computer to determine 

whether your data bus can take advantage of the speed of a component you want to add.

 For more information, see “Optimizing system performance” in the Adobe Premiere 6.0 

Technical Guides found in the Support area on the Adobe Web site 

(www.adobe.com/products/premiere/community.html).

Capturing to support online or offline editing

Depending on the level of quality you want and the capabilities of your equipment, you 

may be able to use Premiere for either online or offline editing. The settings you specify 

for video capture are different for online or offline editing.

Online editing The practice of doing all editing (including the rough cut) using the same 

source clips that will be used to produce the final cut. As high-end personal computers 

have become more powerful, online editing has become practical for a wider range of 

productions such as broadcast television or motion-picture film productions. For online 

editing, you’ll capture clips once, at the highest level of quality your computer and 

peripherals can handle.

Offline editing The practice of preparing a rough cut from lower-quality clips, then 

producing the final version with higher-quality clips, sometimes on a high-end system. 

Offline editing techniques can be useful even if your computer can handle editing at the 

quality of your final cut. By batch-capturing video using low-quality settings, you can edit 

faster, using smaller files. When you digitize video for offline editing, you specify settings 

that emphasize editing speed over picture quality. In most cases, you need only enough 

quality to identify the correct beginning and ending frames for each scene. When you’re 

ready to create the final cut, you can redigitize the video at the final-quality settings. 

Once you have completed the offline edit in Premiere, you can create a table of scene 

sequences called an Edit Decision List, or EDL. You can then move the EDL to an edit 

controller on a high-end system, which applies the sequence worked out in Premiere to 

the original high-quality clips. 

Note: Typically, offline editing is not employed when working with DV, because Premiere 

handles DV at its original quality level.
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For more information on all the topics covered in this section on capturing video, see 

Chapter 2, “Capturing and Importing Source Clips” in the Adobe Premiere 6.0 User Guide.

Using the DV Device Control Options

Adobe Premiere 6.5 makes it easy to choose an appropriate setting for your DV device 

control. You simply choose a preset from a default list of tested devices. 

To choose a DV device option preset:

1 Do one of the following:

• Choose Edit > Preferences > Scratch Disks & Device Control (Windows and Mac OS 9).

• Choose Adobe Premiere 6.5 >Preferences > Scratch Disks & Device Control (Mac OS X).

2 In the Device Control section, choose DV Device Control 2.0 from the Device menu.

3 Click the Options button below the Device menu.

4 In the DV Device Control Options dialog box, set any of the following options and 

click OK:

Video Standard Specifies the video format.

Device Brand Specifies the device manufacturer.

Device Type Specifies the device model number.

Timecode Format Specifies the device timecode format.

Check Status Tells you if the device is connected.

Go Online for Device Info Opens the Web page that lists the latest compatible devices.

Congratulations on completing the Basic Editing lesson!

Understanding transparency and superimposing
Transparency allows a clip (or any portion of a clip) to reveal a second, underlying clip, 

so that you can create composites, transitions, or other effects. A variety of transparency 

types are available in Premiere. The transparency types are described in this section.

Matte or mask An image that specifies transparent or semitransparent areas for another 

image. For example, if you want to superimpose an object in one clip over the background 

of another clip, you can use a mask to remove the background of the first clip. You can use 
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other still-image or motion graphics software (such as Adobe Photoshop or Adobe After 

Effects) to create a still-image or moving (traveling) matte and apply it to a clip in your 

Premiere project. A mask works like a film negative; black areas are transparent, white 

areas are opaque, and gray areas are semitransparent—darker areas are more transparent 

than lighter areas. You can use shades of gray to create feathered (soft-edged) or 

graduated masks.

Alpha channel Color in an RGB video image is stored in three color channels—one red, 

one green, and one blue. An image can also contain a mask in a fourth channel called the 

alpha channel. By keeping an image together with its mask, you don’t have to manage two 

separate files. (Sometimes, however, saving a mask as a separate file can be useful; such as 

when creating a track matte effect, because the mask must be placed in a separate track in 

Premiere’s Timeline. 

A 32-bit frame has four 8-bit channels: red, green, blue, and an alpha 
channel mask.

Programs such as Adobe Photoshop and Adobe After Effects let you paint or draw a mask 

and use the alpha channel to keep the mask with the image or movie. 

Premiere uses the alpha channel for compositing.

Photoshop image (left) contains an alpha channel mask (center), which Premiere uses 
to composite the subject against another background (right).
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Keying Finds pixels in an image that match a specified color or brightness and makes 

those pixels transparent or semitransparent. For example, if you have a clip of a 

weatherman standing in front of a blue-screen background, you can key out the blue and 

replace it with a weather map.

Opacity Allows you to control the degree of overall transparency for a clip. You can use 

opacity to fade a clip in or out.

With Premiere, you can combine the transparency options described here. For example, 

you can use a matte to remove the background from one clip and superimpose it over a 

second clip, and then use opacity to fade-in the first clip’s visible area.

Using audio in a video
Audio can play an equally important role to imagery in telling your story. In Adobe 

Premiere 6.5, you can adjust audio qualities in the Timeline window, or use the Audio 

Mixer with greater flexibility and control when mixing multiple audio tracks. For 

example, you might combine dialogue clips with ambient background sounds and a 

musical soundtrack. Mixing audio in Premiere can include any combination of the 

following tasks:

• Fading, (increasing or decreasing) the volume levels of audio clips over time.

• Panning/balancing monophonic audio clips between the left and right stereo channels. 

For example, you may want to pan a dialogue clip to match a person’s position in the 

video frame.

• Using audio effects to remove noise, enhance frequency response and dynamic range, 

sweeten the sound, or create interesting audio distortions such as reverb.

When you import a video clip that contains audio, the audio track is linked to its video 

track by default so that they move together. Adobe Premiere 6.5 allows you to adjust and 

mix audio while you watch the corresponding video in Real-Time. The Audio Mixer 

window, like an audio mixing console in a professional sound studio, contains a set of 

controls for each audio track; each set is numbered to match its corresponding audio 

track in the Timeline. When you edit superimposed video tracks, remember to consider 

the effects of your edits on the audio tracks.

For more information, see Chapter 5, “Mixing Audio,” in the Adobe Premiere 6.0 

User Guide.
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Understanding digital audio

You hear sounds because your ear recognizes the variations in air pressure that create 

sound. Analog audio reproduces sound variations by creating or reading variations in an 

electrical signal. Digital audio reproduces sound by sampling the sound pressure or signal 

level at a specified rate and converting that to a number.

The quality of digital audio depends on the sample rate and bit depth. The sample rate is 

how often the audio level is digitized. A 44.1 kHz sample rate is audio-CD-quality, while 

CD-ROM or Internet audio often uses a sample rate of 22 kHz or below. The bit depth is 

the range of numbers used to describe an audio sample; 16 bits is audio-CD-quality. 

Lower bit depths and sample rates are not suitable for high-fidelity audio, but may be 

acceptable (though noisy) for dialogue. The file size of an audio clip increases or decreases 

as you increase or decrease the sample rate or bit depth.

Note: DV camcorders support only 32 or 48 kHz audio; not 44.1 kHz. So, when capturing or 

working with DV source material, be sure to set the audio for 32 or 48 kHz.

Keeping audio in sync with video

Be mindful of audio sample rates in relation to the timebase and frame rate of your project. 

The most common mistake is to create a movie at 30 fps with audio at 44.1 kHz, and then play 

back the movie at 29.97 fps (for NTSC video). The result is a slight slowdown in the video, 

while the audio (depending on your hardware) may still be playing at the correct rate and 

therefore will seem to get ahead of the video. The difference between 30 and 29.97 results in a 

synchronization discrepancy that appears at a rate of 1 frame per 1000 frames, or 1 frame per 

33.3 seconds (just under 2 frames per minute). If you notice audio and video drifting apart at 

about this rate, check for a project frame rate that doesn’t match the timebase. 

A similar problem can occur when editing motion-picture film after transferring it to 

video. Film audio is often recorded on a digital audio tape (DAT) recorder at 48 kHz 

synchronized with a film camera running at 24 fps. When the film is transferred to 30 fps 

video, the difference in the video frame rate will cause the audio to run ahead of the video 

unless you slow the DAT playback by 0.1% when transferring to the computer. Using your 

computer to convert the sample rate after the original recording doesn’t help with this 

problem. The best solution is to record the original audio using a DAT deck that can 

record 0.1% faster (48.048 kHz) when synchronized with the film camera.
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Older CD-ROM titles sometimes used an audio sample rate of 22.254 kHz; today, a rate 

of 22.250 kHz is more common. If you notice audio drifting at a rate accounted for by the 

difference between these two sample rates (1 frame every 3.3 seconds), you may be mixing 

new and old audio clips recorded at the two different sample rates.

Note: You can use Adobe Premiere 6.5 or a third-party application to resample the audio. If 

you use Premiere, be sure to turn on Enhanced Rate Conversion in Project Settings > Audio. 

Then, build a preview of the audio by applying an audio effect with null settings.

Creating final video
When you have finished editing and assembling your video project, Adobe Premiere 6.5 

offers a variety of flexible output options. You can:

• Record your production directly to DV or analog videotape by connecting your 

computer to a video camcorder or tape deck. If your camera or deck supports device 

control, you can automate the recording process, using timecode indications to selectively 

record portions of your program.

• Export a digital video file for playback from a computer hard drive, removable 

cartridge, CD, or DVD-ROM. Adobe Premiere exports Advanced Windows Media, 

RealsMedia, AVI, QuickTime, and MPEG files; additional file formats may be available in 

Premiere if provided with your video-capture card or third-party plug-in software.

• Use Advanced RealMedia, or Advanced Windows Media (Windows only) export 

options to generate properly encoded video files for distribution over the Internet or your 

intranet. Adobe Premiere 6.5 exports QuickTime, RealMedia, and Windows Media 

formats for download, progressive download, or streaming. 

• Create an EDL (Edit Decision List) so you can perform offline editing based on a rough 

cut, when you require a level of quality that your system cannot provide. 

• Output to motion-picture film or videotape if you have the proper hardware for film or 

video transfer or access to a vendor that offers the appropriate equipment and services.

For more information, see Chapter 10, “Producing Final Video” in the Adobe Premiere 6.0 

User Guide. 
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Review questions
1 What’s the difference between the timebase and the project frame rate?

2 Why is non-drop-frame timecode important for NTSC video?

3 How is interlaced display different from progressive scan?

4 Why is data compression important?

5 What’s the difference between applying a mask and adjusting opacity?

6 What is an EDL and why is it useful?

Answers
1 The timebase specifies the time divisions in a project. The project frame rate specifies 

the final number of frames per second that are generated from the project. Movies with 

different frame rates can be generated from the same timebase; for example, you can 

export movies at 30, 15, and 10 frames per second from a timebase of 30.

2 Counting NTSC frames using a timecode of 30 fps causes an increasingly inaccurate 

program duration because of the difference between 30 fps and the NTSC frame rate of 

29.97 fps. Drop-frame timecode ensures that the duration of NTSC video will be 

measured accurately.

3 Interlacing, used by standard television monitors, displays a frame’s scan lines in two 

alternating passes, known as fields. Progressive scan, used by computer monitors, displays 

a frame’s scan lines in one pass. 

4 Without data compression, digital video and audio often produce a data rate too high 

for many computer systems to handle smoothly.

5 A mask, also known as a matte in video production, is a separate channel or file that 

indicates transparent or semitransparent areas within a frame. In Premiere, opacity 

specifies the transparency of an entire frame.

6 An EDL is an Edit Decision List, or a list of edits specified by timecode. It’s useful 

whenever you have to transfer your work to another editing system because it lets you 

re-create a program using the timecode on the original clips.
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